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Development

Main a Bisector
The Bisector routine determines the bisecting or symmetry 
feature between the last two compatible features in the 
inspection report.

X X X X

Main Ctrl + a AutoMode
For use with DCC CMMs. This function sets Geomet up for 
continuos program loops.

X X X X

Main Alt + a Analysis Menu Drops down the File Menu. X X X

Main b Plane
Prepares Geomet to measure a basic plane defined by the 
number of points set in the System Default.

X X X X

Main Shift + B Plane
Prepares Geomet to measure a multi-point plane where the 
operator defines the number of data points required.

X X X X

Main Ctrl + b Plane Activates the offline Plane generation tool. X X X X

Main Alt + Shift + b Planar Profile
Activates the online graphic tool for viewing the profile of 
a plane while capturing data points.

X X X

Main c Cylinder
Prepares Geomet to measure a basic cylinder defined by 
the number of points set in the System Default.

X X X X

Main Shift + C
Multi-Point 
Cylinder

Prepares Geomet to measure a multi-point cylinder where 
the operator defines the number of data points required.

X X X X

Main Ctrl + c
Auto & Offline 

Cylinder Activates the offline Cylinder generation tool.
X X X

Main Alt + c
Construct 
Cylinder

Construct a cylinder for use in visual reference and 
constructions.

X X X X

Main d Intersect
The Intersect routine determines the characteristics of the 
intersection of the last two compatible features in the 
inspection report.

X X X X X

Main Ctrl + d Digital Readout Toggle the on screen Digital Readout. X X X
Main Shift + D Full DRO Toggle the Full Digital Readout. X X X
Main e Report Format Switch between Cartesian and Polar X X X X
Main Shift + E Unit of Measure Switch between Inch and Metric reporting modes. X X X X
Main Alt + e Measure Menu Drops down the Measure Menu. X X X X

Main f Angle
The Angle routine determines the angle between the last 
two compatible features in the inspection report.

X X X X

Main Alt + f File Menu Drops down the File Menu. X X X X

Main g Fit Features
This routine constructs features based on the 'x' number 
of features in the Inspection Report.

X X X X

Shortcut and Hot keys available from the main Geomet screen.



Main Ctrl + g GoTo
Prompts the operator to enter a feature number in the 
inspection report that will be scrolled to the top of the 
view.

X X X X

Main Ctrl + g Goto (runtime) On manual CMMs, this routine will rerun program steps. X X X

Main h Recall
Prompts for a feature number to be recalled as a new 
feature in the inspection report.

X X X X

Main Shift + H
Recall PCS 
Component

Prompts for a PCS number which the user can then select 
to recall either a PCS base plane or a 3D point defined as 
the origin.

X(1) X X X

Main Alt + h Help Menu Drops down the Help Menu. X X X X
Main i Delete Delete a feature from the Inspection Report. X X X X
Main Shift + I Insert Insert a new feature into the Inspection Report. X X X X
Main Ctrl + i Move Move a feature in the Inspection Report. X X X X

Main j Orient
Performs a orientation (Primary Datum) using the last 
compatible feature in the Inspection Report.

X X X X

Main Shift + J Quick PCS
Starts the Quick PCS routine. This routine creates a PCS 
based on a Plane, 2 Alignment Points and a Single Point for 
the Origin.

X X X X

Main k Alignment Performs an Alignment (Secondary Datum) based on the 
last 1 or two compatible features in the Inspection Report.

X X X X

Main Shift + K
Offset 

Alignment

Performs a Alignment based on the last two compatible 
features in the Inspection Report. The Offset Alignment 
rotates through the last feature to a specified distance 
from the second feature.

X X X X

Main Ctrl + k Pivot Align
Performs a Alignment based on the current origin rotated 
to the last compatible feature in the Inspection Report.

X X X X

Main l Origin
Establishes an Origin (tertiary Datum) on the last feature in 
the Inspection Report. This routine establishes the origin 
only on the axis compatible with the feature.

X X X X

Main Shift + L FCS Manager Activates the FCS Manager X X X
Main Ctrl + L Library Tools Activates the GeoPlus Libraries X X X
Main Alt + l GeoPlus Menu Drops down the GeoPlus Menu. X X X

Main m Line
Prepares Geomet to measure a basic line defined by the 
number of points set in the System Default.

X X X X

Main Shift + M Multi-Point Line
Prepares Geomet to measure a multi-point line where the 
operator defines the number of data points required.

X X X X

Main Alt + m Construct Line
Construct a line for use in visual reference and 
constructions.

X X X

Main Ctrl + m Auto Line Activates the offline Line generation tool. X X X



Main n Cone
Prepares Geomet to measure a basic cone defined by the 
number of points set in the System Default.

X X X X

Main Shift + N Multi-Point Cone
Prepares Geomet to measure a multi-point cone where the 
operator defines the number of data points required.

X X X X

Main Ctrl + n Auto Cone Activates the offline Cone generation tool. X X X X

Main Alt + n
Report Controls 

Menu Drops down the Report Controls Menu.
X X X

Main o DCC Settings Activates the DCC parameter settings. X
Main Ctrl + o Open Opens a Geomet Inspection Report. X X X X
Main Alt + o Modify Menu Drops down the Modify Menu. X X X X

Main p Feature Tagging
Activates the Feature Tagging routine to set Print 
Exceptions, SPC ASCII Data and GeoStat Tags (based on 
current available features).

X X X

Main Ctrl + p Print
Calls the print routine for a basic Geomet Inspection 
Report.

X X X X

Main Alt + p PCS Menu Drops down the PCS Menu. X X X X
Main q Toggle CAD Toggles the CAD viewer On / Off X X X
Main Alt + q Qualify Menu Drops down the Qualify Menu. X X X X

Main r Tolerance
Toggles Tolerance On / Off. When in On mode, all features 
will prompt a tolerance control to allow the operator to 
enter nominal data before proceeding to the next feature.

X(2) X X X

Main Shift + R
Tolerance 

Format

Permits the selection of Linear or Position modes of 
tolerance. This provides the default tolerance control 
when Tolerance is ON.

X(2) X X X

Main Alt + r Construct Menu Drops down the Construct Menu. X X X X

Main s Distance
The Distance routine determines the point-to-point distance 
between the last two compatible features in the Inspection 
Report.

X X X X

Main Shift + S
Extended 
Distance

The Extended Distance routine allows selection of 
distances other then point-to-point between two features 
that report coplanar diameters. These distance selections 
include outside, center and Tangent points.

X X X

Main Ctrl + s Save
Prompts the operator to save the current Inspection 
Report.

X X X X

Main Ctrl + Shift + S Save As
Prompts the operator to save the current Inspection Report 
under a new name.

X X X X

Main Alt + s System Menu Drops down the System Menu. X X X X

Main t GeoTol
The GeoTol routine consists of various positional and form 
tolerance functions available on the last compatible feature 
in the inspection report.

X X X X



Main Ctrl + T Edit Tolerance
Provides direct access to any feature in the inspection 
report to edit the tolerance.

X(2) X X X

Main Alt + t Tolerance Menu Drops down the Tolerance Menu. X X X X
Main u Auto-Dir Toggles the Auto-Direction sensing when enabled. X X X

Main Ctrl + u Undo
Removes the last record in the Inspection Report and 
resets any characteristics.

X X X X

Main Ctrl + Shift + U Undo / Save Hits

Removes the last record in the Inspection Report and 
resets any characteristics. If the record had any 
associated data points, they would be saved and placed 
back in the Global Hit database.

X X X X

Main v Sphere
Prepares Geomet to measure a basic sphere defined by 
the number of points set in the System Default.

X X X X

Main Shift + V
Multi-Point 

Sphere
Prepares Geomet to measure a multi-point sphere where 
the operator defines the number of data points required.

X X X X

Main Ctrl + v Auto Sphere Activates the offline sphere generation tool. X X X X

Main Alt + v
Construct 
Sphere

Construct a sphere for use in visual reference and 
constructions.

X X X

Main x Stylus Manager
Activates the Stylus Manager used to qualify, re-qualify 
and select various styli.

X(1) X X X

Main Shift + W PH9 Controller
Activates the Motorized Probe Head Controller. Used to 
manually articulate the motorized head.

X(3) X(3) X(3) X(3)

Main Alt + w SCR / MCR
Activates the manual operations of styli bay assignments 
for the SCR200 and MCR20 Stylus Racks.

X(4) X(4) X(4) X(4)

Main Ctrl + Alt + w Stylus Manager
Activates the Stylus Manager to define or recall stylus 
databases.

X X

Main Ctrl + w Re-Qualify Performs a re-qualify on the current active stylus. X(1) X X X
Main y Text Adds a comment feature to the Inspection Report. X X X X

Main Shift + Y User Prompt

Adds a User Prompt to the Inspection Report. The User 
Prompt flashes a text message to the operator and 
suspends auto operations until the operator presses 
<Continue>

X(1) X X X

Main Alt + y Text Input
Places a prompt in the Inspection Report that will pause 
program execution and allow the operator to add 
comments.

X(1) X X X

Main z Circle
Prepares Geomet to measure a basic circle defined by the 
number of points set in the System Default.

X X X X

Main Shift + Z Multi-Point Circle
Prepares Geomet to measure a multi-point circle where the 
operator defines the number of data points required.

X X X X

Main Ctrl + z Auto Circle Activates the offline circle generation tool. X X X

Main Alt + z Construct Circle
Construct a circle for use in visual reference and 
constructions.

X X X



Main Ctrl + 0 View Control Switches to the MCS XY plan view. X X X

Main Ctrl + 1 View Control
Switches to XY plan view. Toggle view point between +Z 
to -Z.

X X X

Main Ctrl + 2 View Control
Switches to ZX plan view. Toggle view point between +Y 
to -Y.

X X X

Main Ctrl + 3 View Control Activates dynamic rotation. X X X

Main Ctrl + 4 View Control
Switches to ZX plan view. Toggle view point between +Y 
to -Y.

X X X

Main Ctrl + 5 View Control
Switches to YZ plan view. Toggle view point between +X 
to -X.

X X X

Main Ctrl + 6 View Control
Switches to YZ plan view. Toggle view point between +X 
to -X.

X X X

Main Ctrl + 7 View Control
Switches to Isometric view. Toggles between the four 
quarters of viewing perspective.

X X X

Main : PCS Rotate
Activates the PCS rotation routine allowing the operator to 
rotate about 1 PCS axis and defined angle.

X X X X

Main ; PCS Translate

Activates the PCS translation routine allowing the operator 
to translate the current PCS a defined distance in XY or Z 
axis. The translation routine allows any combination of XY 
or Z values.

X X X X

Main < Oval Slot
Prepares Geomet to measure a Oval Slot using 6 points, 3 
on each end radius.

X X X X

Main = Vector Point Activates the Vector Point routine. X X X
Main ? Select Scan Activates available scan options to set as default. X X X X

Main " ICS->PCS
Converts the status of the current interim coordinate 
system into a complete PCS.

X X X X

Main '
Coordinate 

System 
Manager

Activates the Coordinate System Manager which allows 
the operator to choose the current PCS, return to MCS, 
activate a DCC CS or recall a Fixture CS.

X(2) X X X

Main +
Wobble 

Coordinate 
System

Creates the current CS into a Wobble CS. Requires WCS 
activation.

X X X

Main , Slot Web Prepares Geomet to measure a Slot Web. X X X X

Main . 4 Point Intersect
Prepares Geomet to measure a 4 Point Intersect.

X X X X

Main / Scan Performs the current selected scan. X X X X
Main [ Load Last Loads the last opened Inspection Report. X X X X

Main ] Save at End
Adds a program routine into the Inspection Report to save 
the Inspection Report at the end of a run.

X X X

Main `
Feature 

Selection Activates the Feature Selection tools.
X X X



Main } Save at End
Adds a program routine into the Inspection Report to save 
the Inspection Report at the end of a run prompting the 
operator for a new name.

X X X

Main -
Geomet Web 

Help Starts Geomet Help on the Web.
X X X

Main 1 1D -Y Point Prepares Geomet to measure a -Y Point. X X X X
Main 2 1D -Z Point Prepares Geomet to measure a -Z Point. X X X X
Main 4 1D -X Point Prepares Geomet to measure a -X Point. X X X X
Main 6 1D +X Point Prepares Geomet to measure a +X Point. X X X X
Main 8 1D +Z Point Prepares Geomet to measure a +Z Point. X X X X
Main 9 1D +Y Point Prepares Geomet to measure a +Y Point. X X X X



File Menu Alt + f + N Restart Restarts Geomet and prepares for a new Inspection. X X X X
File Menu Alt + f + o Open Prompts to open an existing Inspection Report. X X X X
File Menu Alt + f + s Save Saves the current Inspetion Report. X X X X
File Menu Alt + f + a Save As Saves the current Inspection Report under a new name. X X X X
File Menu Alt + f + u Run Runs the current Inspection Program. X X X X
File Menu Alt + f + r Recover Recovers the last known inspection report. X X X X
File Menu Alt + f + i Import Imports available file formats. X X X X
File Menu Alt + f + e + e Export Selector Activates the Export Selection Tool. X X X X

File Menu Alt + f + e + a Export SPC
On demand export of any SPC Tagged data to the spc data 
file.

X X X X

File Menu Alt + f + p Print Prints a standard Geomet report X X X X
File Menu Alt + f + x Exit Exits Geomet. X X X X

Qualify Menu Alt + q + s Stylus Manager
Activates the Stylus Manager used to qualify, re-qualify 
and select various styli.

X(1) X X X

Qualify Menu Alt + q + m Stylus Manager
Activates the Stylus Manager to define or recall stylus 
databases.

X X

Qualify Menu Alt + q + r Re-Qualify Performs a re-qualify on the current active stylus. X(1) X X X

Qualify Menu Alt + q + o + p
Re-Qualify 

Option Sets the 3D positional tolerance for re-qualify.
X(1) X X X

Qualify Menu Alt + q + o + d
Re-Qualify 

Option Sets the diameter profile tolerance for re-qualify.
X(1) X X X

Qualify Menu Alt + q + a Auto Qualify
Sets the default values for building the auto qualify 
parameters.

X(1) X X X X X

PCS Menu Alt + p + q Quick PCS
Starts the Quick PCS routine. This routine creates a PCS 
based on a Plane, 2 Alignment Points and a Single Point for 
the Origin.

X X X X

PCS Menu Alt + p + n Orient
Performs a orientation (Primary Datum) using the last 
compatible feature in the Inspection Report.

X X X X

PCS Menu Alt + p + a Alignment Performs an Alignment (Secondary Datum) based on the 
last 1 or two compatible features in the Inspection Report.

X X X X

PCS Menu Alt + p + f
Offset 

Alignment

Performs a Alignment based on the last two compatible 
features in the Inspection Report. The Offset Alignment 
rotates through the last feature to a specified distance 
from the second feature.

X X X X

Shortcut and Hot keys available from the Geomet Main Menus.



PCS Menu Alt + p + p Pivot Align
Performs a Alignment based on the current origin rotated 
to the last compatible feature in the Inspection Report.

X X X X

PCS Menu Alt + p + o Origin
Establishes an Origin (tertiary Datum) on the last feature in 
the Inspection Report. This routine establishes the origin 
only on the axis compatible with the feature.

X X X X

PCS Menu Alt + p + i ICS->PCS
Converts the status of the current interim coordinate 
system into a complete PCS.

X X X X

PCS Menu Alt + p + r PCS Rotate
Activates the PCS rotation routine allowing the operator to 
rotate about 1 PCS axis and defined angle.

X X X X

PCS Menu Alt + p + t PCS Translate

Activates the PCS translation routine allowing the operator 
to translate the current PCS a defined distance in XY or Z 
axis. The translation routine allows any combination of XY 
or Z values.

X X X X

PCS Menu Alt + p + m
Coordinate 

System 
Manager

Activates the Coordinate System Manager which allows 
the operator to choose the current PCS, return to MCS, 
activate a DCC CS or recall a Fixture CS.

X(2) X X X

PCS Menu Alt + p + f FCS Manager Activates the FCS Manager X X X

Measure Menu Alt + e + p Point Drops down the Measure Menu. X X X X
Measure Menu Alt + e + v Vector Point Activates the Vector Point routine. X X X

Measure Menu Alt + e + l Line
Prepares Geomet to measure a basic line defined by the 
number of points set in the System Default.

X X X X

Measure Menu Alt + e + c Circle
Prepares Geomet to measure a basic circle defined by the 
number of points set in the System Default.

X X X X

Measure Menu Alt + e + l + l Plane
Prepares Geomet to measure a basic plane defined by the 
number of points set in the System Default.

X X X X

Measure Menu Alt + e + s Sphere
Prepares Geomet to measure a basic sphere defined by 
the number of points set in the System Default.

X X X X

Measure Menu Alt + e + y Cylinder
Prepares Geomet to measure a basic cylinder defined by 
the number of points set in the System Default.

X X X X

Measure Menu Alt + e + o Cone
Prepares Geomet to measure a basic cone defined by the 
number of points set in the System Default.

X X X X

Measure Menu Alt + e + 4 4 Point Intersect
Prepares Geomet to measure a 4 Point Intersect.

X X X X

Measure Menu Alt + e + w Slot Web Prepares Geomet to measure a Slot Web. X X X X

Measure Menu Alt + e + v Oval Slot
Prepares Geomet to measure a Oval Slot using 6 points, 3 
on each end radius.

X X X X

Measure Menu Alt + e + d Scan Performs the current selected scan. X X X X
Measure Menu Alt + e + t Text Adds a comment feature to the Inspection Report. X X X X



Measure Menu Alt + e + u User Prompt

Adds a User Prompt to the Inspection Report. The User 
Prompt flashes a text message to the operator and 
suspends auto operations until the operator presses 
<Continue>

X(1) X X X

Measure Menu Alt + e + m Text Input
Places a prompt in the Inspection Report that will pause 
program execution and allow the operator to add 
comments.

X(1) X X X

Construct Menu Alt + r + l Construct Line Constructs a Line on the last 'x' features. X X X X

Construct Menu Alt + r + c Construct Circle
Constructs a Circle on the last 'x' features.

X X X X

Construct Menu Alt + r + l Construct Plane
Constructs a Plane on the last 'x' features.

X X X X

Construct Menu Alt + r + y
Construct 
Cylinder Constructs a Cylinder on the last 'x' features.

X X X X

Construct Menu Alt + r + o Construct Cone Constructs a Cone on the last 'x' features. X X X X

Construct Menu Alt + r + s
Construct 
Sphere Constructs a Sphere on the last 'x' features.

X X X X

Construct Menu Alt + r + b Bisector
The Bisector routine determines the bisecting or symmetry 
feature between the last two compatible features in the 
inspection report.

X X X X

Construct Menu Alt + r + d Distance
The Distance routine determines the point-to-point distance 
between the last two compatible features in the Inspection 
Report.

X X X X

Construct Menu Alt + r + e
Extended 
Distance

The Extended Distance routine allows selection of 
distances other then point-to-point between two features 
that report coplanar diameters. These distance selections 
include outside, center and Tangent points.

X X X

Construct Menu Alt + r + i Intersect
The Intersect routine determines the characteristics of the 
intersection of the last two compatible features in the 
inspection report.

X X X X X

Construct Menu Alt + r + a Angle
The Angle routine determines the angle between the last 
two compatible features in the inspection report.

X X X X

Construct Menu Alt + r + e Recall
Prompts for a feature number to be recalled as a new 
feature in the inspection report.

X X X X

Construct Menu Alt + r + p
Recall PCS 
Component

Prompts for a PCS number which the user can then select 
to recall either a PCS base plane or a 3D point defined as 
the origin.

X(1) X X X



Tolerance Menu Alt + t + <enter> Tolerance
Toggles Tolerance On / Off. When in On mode, all features 
will prompt a tolerance control to allow the operator to 
enter nominal data before proceeding to the next feature.

X(2) X X X

Tolerance Menu Alt + t + f
Tolerance 

Format

Permits the selection of Linear or Position modes of 
tolerance. This provides the default tolerance control 
when Tolerance is ON.

X(2) X X X

Tolerance Menu Alt + t + o OOT Notification
Activates OOT Warning through an on screen notification 
or , if available, external warnings.

X X X

Analysis Menu Alt + a + c Circular Profile
Activates the circular profile control to view a previously 
measured pr constructed circle.

X X X

Analysis Menu Alt + a + f Planar Profile
Activates the online graphic tool for viewing the profile of 
a plane while capturing data points.

X X X

Analysis Menu Alt + a + o Cone Offset
Reports the offset distance from the PCS of as given 
diamter on the cone.

X X X X

Analysis Menu Alt + a + d Cone Diameter
Reports the diameter on a cone at a given offset from the 
PCS.

X X X X

Analysis Menu Alt + a + t Cone Drop Test
Reports the diameter and the XYZ of the top or center of a 
given ball 'dropped' into a cone.

X X X X

Analysis Menu Alt + a + s GeoStat Activates GeoStat if available. X X X X
Analysis Menu Alt + a + a Point Profile Updates the data cloud fitting to features or CAD model. X X

Analysis Menu Alt + a + g
Setup Gage 

R&R
Establish the parameters for a Gage R&R Study. Must 
have Geomet Gage R&R available.

X X X X

Analysis Menu Avt + a + v View Gage R&R
Activate the Geomet Gage R&R application.

X(5) X(5) X(5) X(5)

Analysis Menu Alt + a + l Calculator Activate the Windows calculator. X X X X

Modify Menu Alt + o + d Delete Delete a feature from the Inspection Report. X X X X
Modify Menu Alt + o + a Delete all Delete all features after a defined number. X X X X
Modify Menu Alt + o + i Insert Insert a new feature into the Inspection Report. X X X X
Modify Menu Alt + o + m Move Move a feature in the Inspection Report. X X X X

Modify Menu Alt + o + j GoTo
Prompts the operator to enter a feature number in the 
inspection report that will be scrolled to the top of the 
view.

X X X X

Modify Menu Alt + o + p Edit Motion Map
Activates the Motion Map Editor allowing access to the 
individial motion associated with a feature.

X(2) X X X X

Modify Menu Alt + o + u Undo
Removes the last record in the Inspection Report and 
resets any characteristics.

X X X X



Report Controls Menu Alt + n + a Report Filters
Activate report filters to select by type which features to 
show in the report.

X X X

Report Controls Menu Alt + n + h Report Header Activate the Inspection Report Header. X X X X

Report Controls Menu Alt + n + c
Report Control 

Center Activate the Report Control Center.
X X X

Report Controls Menu Alt + n + r Concise Report
Add to the Inspection Report a feature to automatically 
print a concise report.

X X X

Report Controls Menu Ant + n + g GeoTracker
Activate GeoTracker, production management tools for 
Geomet.

X X X X

System Menu Alt + s + v + t View Control
Switches to XY plan view. Toggle view point between +Z 
to -Z.

X X X

System Menu Alt + s + v + f View Control
Switches to ZX plan view. Toggle view point between +Y 
to -Y.

X X X

System Menu Alt + s + v + s View Control
Switches to YZ plan view. Toggle view point between +X 
to -X.

X X X

System Menu Alt + s + v + i View Control
Switches to Isometric view. Toggles between the four 
quarters of viewing perspective.

X X X

System Menu Alt + s + v + m View Control Switches to the MCS XY plan view. X X X
System Menu Alt + s + v + c View Control Activates dynamic rotation. X X X
System Menu Alt + s + z + z View Control Zoom in. X X X
System Menu Alt + s + z + u View Control Zoom Out. X X X
System Menu Alt + s + z + f View Control Fit to screen. X X X
System Menu Alt + s + d Digital Readout Toggle the on screen Digital Readout. X X X
System Menu Alt + s + s Tool Bars Activates the customized tool bar states. X X X
System Menu Alt + s + r + r Display Displays the Inspection Results and turns CAD off. X X X
System Menu Alt + s + r + b Display Displays the Inspection Results and turns CAD on. X X X
System Menu Alt + s + o Offline Toggles the CMM online to offline. X X

System Menu Alt + s + h Hits
Taggles the display of data points when a feature has 
been highlighted.

X X X

System Menu Alt + s + e + w Rendering Set CAD to display in Wireframe. X X X
System Menu Alt + s + e + s Rendering Set CAD to display in Solids. X X X
System Menu Alt + s + e + t Rendering Set CAD to display in Transparent. X X X
System Menu Alt + s + b Beep Toggles the system Beep On / Off. X X X X
System Menu Alt + s + d DCC Settings Activates the DCC parameter settings. X
System Menu Alt + s + b + x Brakes Activate the X brake. X
System Menu Alt + s + b + y Brakes Activate the Y brake. X
System Menu Alt + s + b + z Brakes Activate the Z brake. X
System Menu Alt + s + b + e Brakes Activate All brakes. X
System Menu Alt + s + b + d Brakes Disengage all brakes X



System Menu Alt + s + y System Options
Activate the Geomet System Option control.

X X X X

System Menu Alt + s + i
Interface 

Configuration
Activate the CMM Interface configuration control if 
available.

X X X X

System Menu Alt + s + a CMM Interface Indentifies the current CMM interface. X X X X

System Menu Alt + s + g
Gaussmeter 

Interface Activates the MII Gaussmeter Interface if attached.
X X X

System Menu Alt + s + h DCC Home Perform a DCC home move if required. X X X X X

GeoPlus Menu Alt + l + l Library Tools Activates the GeoPlus Libraries X X X
GeoPlus Menu Alt + l + o Report Offsets Activate the report offset tools. X X X

GeoPlus Menu Alt + l + f Feature Tagging
Activates the Feature Tagging routine to set Print 
Exceptions, SPC ASCII Data and GeoStat Tags (based on 
current available features).

X X X

GeoPlus Menu Alt + l + d
Default Feature 

Tags Activate the default options for auto feature tags.
X X X

GeoPlus Menu Alt + l + s
System 

Administration
Activate the System Administration tools providing access 
to passwords and file locking.

X X X

GeoPlus Menu Alt + l + a File Lock Add or Remove a file lock on a Inspection Report. X X X



Direction Selector 1 -Y
Selects the -Y direction for use with Planes, Lines and 
Points.

X X X X

Direction Selector 2 -Z
Selects the -Z direction for use with Planes, Lines and 
Points.

X X X X

Direction Selector 3 IR Points Provides access to measure 2D / 3D IR Points. X X X X

Direction Selector 4 -X
Selects the -X direction for use with Planes, Lines and 
Points.

X X X X

Direction Selector 5 2D/3D Points Provides access to 2D, 3D, and Vector Points. X X X X

Direction Selector 6 +X
Selects the +X direction for use with Planes, Lines and 
Points.

X X X X

Direction Selector 7 OR Points Provides access to measure 2D / 3D OR Points. X X X X

Direction Selector 8 +Z
Selects the +Z direction for use with Planes, Lines and 
Points.

X X X X

Direction Selector 9 +Y
Selects the +Y direction for use with Planes, Lines and 
Points.

X X X X

Direction Selector 3 + 2 IR XY Point Prepares Geomet to measure a 2D XY IR Point. X X X X
Direction Selector 3 + 4 IR ZX Point Prepares Geomet to measure a 2D ZX IR Point. X X X X
Direction Selector 3 + 6 IR YZ Point Prepares Geomet to measure a 2D YZ IR Point. X X X X
Direction Selector 3 + 9 IR 3D Point Prepares Geomet to measure a 3D IR Point. X X X X
Direction Selector 5 + 2 2D XY Point Prepares Geomet to measure a 2D XY Point. X X X X
Direction Selector 5 + 4 2D ZX Point Prepares Geomet to measure a 2D ZX Point. X X X X
Direction Selector 5 + 6 2D YZ Point Prepares Geomet to measure a 2D YZ Point. X X X X
Direction Selector 5 + 7 Vector Point Activates the Vector Point routine. X X X
Direction Selector 5 + 9 3D Point Prepares Geomet to measure a 3D Point. X X X X
Direction Selector 7 + 2 OR XY Point Prepares Geomet to measure a 2D XY OR Point. X X X X
Direction Selector 7 + 4 OR ZX Point Prepares Geomet to measure a 2D ZX OR Point. X X X X
Direction Selector 7 + 6 OR YZ Point Prepares Geomet to measure a 2D YZ OR Point. X X X X
Direction Selector 7 + 9 OR 3D Point Prepares Geomet to measure a 3D OR Point. X X X X

Probing Direction 1 -Y Direction
Used with 1D Points, Lines and Planes to establish the 
probing direction.

X X X X

Probing Direction 2 -Z Direction
Used with 1D Points, Lines and Planes to establish the 
probing direction.

X X X X

Probing Direction 4 -X Direction
Used with 1D Points, Lines and Planes to establish the 
probing direction.

X X X X

Probing Direction 6 +X Direction
Used with 1D Points, Lines and Planes to establish the 
probing direction.

X X X X

Shortcut and Hot keys available within Dialog controls.



Probing Direction 8 +Z Direction
Used with 1D Points, Lines and Planes to establish the 
probing direction.

X X X X

Probing Direction 9 +Y Direction
Used with 1D Points, Lines and Planes to establish the 
probing direction.

X X X X

Rad/Dia Selector 2 ID Used to establish the feature characteristics. X X X X
Rad/Dia Selector 4 IR Used to establish the feature characteristics. X X X X
Rad/Dia Selector 6 OD Used to establish the feature characteristics. X X X X
Rad/Dia Selector 8 OR Used to establish the feature characteristics. X X X X

Stylus Manager + Set Active Sets the current selected stylus active for measuring. X(2) X X X

Stylus Manager - + - Remove
When no stylus has been highlighted, removes all styli in 
the database. When a single stylus is highlighted, removed 
just that one.

X(2) X X X

Stylus Manager <Enter> Next Page
Advances the Stylus Manager Wizard to the next available 
page.

X(2) X X X

Stylus Manager ? Move Up Moves up to the next stylus in the list. X(2) X X X
Stylus Manager ? Move Down Moves down to the next stylus in the list. X(2) X X X

Stylus Manager l Label
Available when a stylus is highlighted, activates the 
naming option to attach a label to the stylus.

X(2) X X X

Qualify Type b Ball Selects Ball type qualification. X(2) X X X
Qualify Type t Taper Selects Taper type qualification. X(2) X X X
Qualify Type c Cylinder Selects Cylinder type qualification. X(2) X X X
Qualify Type e Enter Manual Enter probe diamter manually. X(2) X X X
Qualify Type c + c Cross Hair Creates a stylus for use with a video cross hair. X(2) X X X
Qualify Type e + e Cross Hair Creates a stylus for use with a edge finder rotating probe. X(2) X X X

Qualify Type s SP600
Selects the calibration method for use with the Renishaw 
SP600.

X X X X

Qualify Type Alt + b Previous Returns to previous page. X(2) X X X

Qualify Type <Enter> Next Page
Advances the Stylus Manager Wizard to the next available 
page.

X(2) X X X

Qualification Page Alt + b Previous Returns to previous page. X(2) X X X

Motorized Probe Page 8 A/B Position
Advances the angular step one position in the +A 
direction.

X(2) X X X

Motorized Probe Page 2 A/B Position
Advances the angular step one position in the -A direction.

X(2) X X X

Motorized Probe Page 6 A/B Position
Advances the angular step one position in the +B direction.

X(2) X X X



Motorized Probe Page 4 A/B Position
Advances the angular step one position in the -B direction.

X(2) X X X

Motorized Probe Page 5 A/B Position
Returns the user defined "Home" position for the motorized 
probe.

X(2) X X X

Motorized Probe Page Alt + b Previous Returns to previous page. X(2) X X X

Motorized Probe Page <Enter> Next Page
Advances the Stylus Manager Wizard to the next available 
page.

X(2) X X X

MCR Bay Assignment s Show Status
Toggle between Open and Close the graphic viewer 
showing the current bay assignments.

X(2) X X X

MCR Bay Assignment 1 Select Bay Select the numbered bay for stylus association. X(2) X X X
MCR Bay Assignment 2 Select Bay Select the numbered bay for stylus association. X(2) X X X
MCR Bay Assignment 3 Select Bay Select the numbered bay for stylus association. X(2) X X X
MCR Bay Assignment 4 Select Bay Select the numbered bay for stylus association. X(2) X X X
MCR Bay Assignment 5 Select Bay Select the numbered bay for stylus association. X(2) X X X
MCR Bay Assignment 6 Select Bay Select the numbered bay for stylus association. X(2) X X X
MCR Bay Assignment Alt + b Previous Returns to previous page. X(2) X X X

MCR Bay Assignment <Enter> Next Page
Advances the Stylus Manager Wizard to the next available 
page.

X(2) X X X

MCR Bay Assignment p Park
Park an the current attached module into it's assigned bay. 
Only available in maintenance mode..

X(2) X X X

MCR Bay Assignment l Load
Load the requestedmodule onot the CMMs probe head. 
Only available in maintenance mode..

X(2) X X X

MCR Bay Assignment p M
Activate the Maintanenace mode. Not available during 
stylus qualification mode.

X(2) X X X

Auto Circle Alt + c Create Path Validates entered parameters and creates a motion path. X X X X
Auto Circle Alt + d Defaults Apply defaults for number of hits and sweep arc. X X X X

Auto Circle Alt  + a All Around
Creates a uniform motion path where the sweep between 
hits is defined as 360 / ( hits - 1 ).

X X X X

Auto Circle Alt + w Working CS
Activates the Working CS manager to create and manage 
clearance CS.

X X X X

Auto Circle Alt + e Entry IP Add a auto entry IP. X X X X
Auto Circle Alt + i Exit IP Add a auto exit IP. X X X X
Auto Circle Alt + o Offline IP Activate the Offline IP generator. X X X X

Auto Circle Alt + p
Relative 

Adjustment Perform the relative adjustment to the XYZ position.
X X X X

Auto Circle Alt + r Review Review the current settings and warnings. X X X X

Auto Circle Alt + x Execute / Close
Execute the defined motion and create the circle feature.

X X X X



Auto Cylinder Alt + c Create Path Validates entered parameters and creates a motion path. X X X X
Auto Cylinder Alt + d Defaults Apply defaults for number of hits and sweep arc. X X X X

Auto Cylinder Alt  + a All Around
Creates a uniform motion path where the sweep between 
hits is defined as 360 / ( hits - 1 ).

X X X X

Auto Cylinder Alt + w Working CS
Activates the Working CS manager to create and manage 
clearance CS.

X X X X

Auto Cylinder Alt + e Entry IP Add a auto entry IP. X X X X
Auto Cylinder Alt + i Exit IP Add a auto exit IP. X X X X
Auto Cylinder Alt + o Offline IP Activate the Offline IP generator. X X X X

Auto Cylinder Alt + p
Probe Auto 

Adjust
Adjust the end points inward 125% of the current probe 
radius.

X X X X

Auto Cylinder Alt + r Review Review the current settings and warnings. X X X X

Auto Cylinder Alt + x Execute / Close
Execute the defined motion and create the circle feature.

X X X X

Auto Cylinder Alt + u Update
Updates the motion path, size and positional data from the 
new data entered in the control.

X X X X

Auto Cylinder Alt + l Clear All Clears any tagged-for-removeal tags on individual slices. X X X X
Auto Cylinder <Insert> Slice Control Adds one additional slice count. X X X X
Auto Cylinder <delete> Slice Control Toggles the delete tag on the current selected slice. X X X X

Working CS Alt + s Select PCS
Set the highlighted PCS in the display list as the current 
PCS to build a working CS from.

X X X X

Working CS Alt + u Un Select Unselect any selected PCS in the display list. X X X X
Working CS Alt + t Translate Translate an existing WCS the specified XYZ offset. X X X X
Working CS Alt + z Zero All Zero the edit controls. X X X X

Working CS Alt + u Update
Update the selected WCS with the new values in the edit 
controls.

X X X X

Working CS Alt + c Create
Create a WCS based on the XYZ offset values and the 
current selected PCS.

X X X X

Working CS Alt + d Delete Delete the highlighted WCS. X X X X
Working CS Alt + w Clear All WCS Clear all WCS from the Inspection Report. X X X X

Offline IP Alt + a Absolute IP
Create a absolute IP based on the values in the XYZ edit 
controls.

X X X X

Offline IP Alt + g Get 1st Point Retreive the current first SO int the motion map. X X X X

Offline IP Alt + r Relative IP
Create a IP based on the selected IP in the display list and 
the addition of the XYZ values in the edit controls.

X X X X

Offline IP Alt + 1 Auto IP
Create a Auto-IP in the X axis to the YZ base plane of the 
current working CS.

X X X X

Offline IP Alt + 2 Auto IP
Create a Auto-IP in the Y axis to the ZX base plane of the 
current working CS.

X X X X



Offline IP Alt + 3 Auto IP
Create a Auto-IP in the Z axis to the XY base plane of the 
current working CS.

X X X X

Offline IP Alt + x Auto IP
Create a two part motion path moving in the Y direction to 
the YZ base plane of the current WCS, then traverse in 
the YZ base plane over the first SO of the feature.

X X X X

Offline IP Alt + y Auto IP
Create a two part motion path moving in the Y direction to 
the ZX base plane of the current WCS, then traverse in the 
ZX base plane over the first SO of the feature.

X X X X

Offline IP Alt + z Auto IP
Create a two part motion path moving in the Z direction to 
the XY base plane of the current WCS, then traverse in 
the XY base plane over the first SO of the feature.

X X X X

Offline IP Alt + w Select WCS

Tolerance Format b Linear Select BiLateral (Linear) tolerance mode. X(2) X X X
Tolerance Format m MMC Select MMC tolerance mode. X(2) X X X
Tolerance Format l LMC Select LMC tolerance mode. X(2) X X X
Tolerance Format r RFS Select RFS tolerance mode. X(2) X X X
Tolerance Format <Esc> Cancel

Text Dialog Alt + p Print Tag Attached a Print Tag on the text statement. X X X


